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Connect Fiji and OMERO (1/2)

Prerequisite:
You have downloaded Fiji (https://fiji.sc) and have access to the OMERO instance
(direct or VPN)

1. Download the OMERO plugin for Fiji 2. Move the omero-ij-x.x.x-all.jar file to
from the OME downloads website: the Plugins folder of your Fiji

https://www.openmicroscopy.org/omero/downloads application
+ = | Downloads = (m] X v
m Start Freigeben Ansicht %) m Start Freigeben Ansicht ()
OMERO p|ugins t & > Die.. > Downl.. v O « T « Fijia.. > plugins v O

Heute (3) Analyze

omero_ij-5.7.2-all jar Examples
JRuby

Macros

l 1 I Scripts
| Utilities

3D_Blob_Segmentation-3.0.1jar
3D_Objects_Counter-2.0.1.jar
Image J / Fiji 3DV

2-alliar AnalyzeSkeleton_-3.4.2 jar

View instructions at Using Image] with b Anisotropic_Diffusion_2D-2.0.1jar
OMERO. n Archipelago_Plugins-0.5.4jar
" Arrow_-2.0.2jar
Vi \ Auto_Local_Threshold-1.10.1,jar
( & Download (74 MB) . |
- ' Auto_Threshold-1.17.2 jar
1 BalloonSegmentation_-3.0.1,jar
bigdataviewer_fiji-6.2.2jar
i “

bigwarp_fiji-7.0.5 jar

p 4 See the official OMERO guide: https://omero-guides.readthedocs.io/en/latest/fiji/docs/index.html ADD LOGO SMALL
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Connect Fiji and OMERO (2/2)

3. Open Fijiand go to

Plugins > OMERO - Connect to OMERO

4. Log in to OMERO with your user credentials.

++OMERO

> §\
r ¢

Omero server address [High] =

Username: ‘USER

9

Password [ .............. ‘

Login Quit
| gut_

The Fiji-OMERO plugin looks almost precisely like OMERO.insight, but is, in fact, part of the open Fiji application

I (Fiji Is Just) Image)
File Edit Image Process Analyze [[ZINFIEE Window Help
B olc|v|/ ]\ A

Scrolling tool (or press space bar and drag)

Macros
Shortcuts

Utilities

New

Compile and Run
Install Strg+Umschalt+M

Install Plugin

3D Viewer

Analyze

Bl

BigDataViewer
Bio-Formats

Cluster

Color Inspector 3D
Examples

Feature Extraction
HDF5

Image5D

Integral Image Filters
Janelia H265 Reader
LOCI

LSM Toolbox
Landmarks
Multiview Reconstruction

- o X
!’&Rm»

R )
>

»

»

»

>

>

»

>

»

»

>

>

>

»

>

»

>

OMERO *| Connectto OMERO

Optic Flow
Process
Registration
Ridge Detection
SPIM Registration
Segmentation

-

» Savelmage(s)to OMERO
*| Save ROIs to OMERO
* Save Results to OMERO

omoniE

Nat Methods 9, 676-682 (2012). https://doi.org/10.1038/nmeth.2019

Fiji publication: Schindelin, J., Arganda-Carreras, I., Frise, E. et al. Fiji: an open-source platform for biological-image analysis.
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OMERO plugin for Fiji versus OMERO.insight

NOTE: The window looks similar to OMERO.insight, but it is a You can distinguish the applications

different application. For example, OMERO.insight has no View by their appearance in the task bar.
in ImageJ function nor allows Save ImageJ Results.

1" (Fiji Is Just) Image) Mary Mayperson connecte...
+*+ Mary Mayperson connected to - [m} X
File Edit Window Help
[E]1 % M m| § | & DisplayGroups v Save Image) Resuits
P AEoces S’ &7 ~ |~ fiter images EE ¢ |l 6 | @) ) S | Amstion | Preview
i % BxXe BoO&k Workspace: 14 of 14 images Full Viewer ms /s
. GROUP 20171123 _tERK_D_03_3h.czi (07 09.2022)

. Mary Mayperson 20171123 tERK D_03_3h.czi 7

+-@l 2010_CMBE_ExpressionTest [2] I :57918

+-@l 2011_VTK_ZyxinConfocal [1] “; Mary Mayperson e
+- @l 2012_MPIMolBio_CrossSec_Lymphangio [1]

EI™ 22017 Nuc-Intens_Tcels [6] Image Details A

+- Wl 2017 _TestStaining_Thio [1]

+ @l 2022_ExampleData_BIA-S-BSST749 [1] 2
% @l OpenSPIM Example Datasset [1]
+ , Orphaned Images Import Date: 20220302 10:12:37

Dimensions (XY): 1912 x 1912

Pixel Type: unt16
Pixels Slx! (XY) (nm): 70,58:70,58

Z-sections/Timepoints: 131 Mary Mayperson connected to ...
Channels: Ch2-T1, Chi-T2 /‘
ROI Count: o -..,- - : = =

Tags (1) ¥ e . { 53 x | ana
INEE : 0 AEEEEEEEN -

: ~ SEEEEEEEE

_ ok : EEFTEEE

B Screens ¥

£ Attachments . Comments (0)
d Located in

) Tags -

Q) Images

& Administration

Search =\ ¥ Wy »

OMERO. insight
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Select image(s) to open in Fiji (1/2)

+** Mary Mayperson connected to — 0 X
File Edit Window Help
] \dl !] % & Display Groups ¥ Save Image) Results
¢ i 4
" Projects )| ©7 v [+ fiter mages = =E e \j‘ JGenevd Acquisition  Preview
1 S I t - % AXE B \Workspace: 14 of 14 images Full Viewer ms /. s
. e eC “ I lage S = GROUP A 20171123_tERK_D_03_3h.czi (D7 09.2022) | View.. 2
M M 201711 . 4
1 T darZYO lOa)gIJVeBrESOEnxpvessaonTest [ ‘ Vi In iraged.- N
rom the file tree - tmage 07918
£ @k 2011_VTK_ZyxinCon e Owner: Mary Mayperson + Show all
. I + @ ..._MPIMolBio_CrossSec_Lymphangio [1]
2 O e n I n FI I b =@l 2017_Nuc-Intens_Tcells [6] Image Details
. ¥ 20171115_M33_pERK [25]
5 [25)
. . +- i 20171123_M36_pERK [27] 7
CI | Ckl n g =B 20171123_M36_totalERK [14]
=] 20171123_tFRK_D_01_0Oh.czi Import Date: 2022-03-02 10:12:37
. =] 20171123_tERK_D_01_3h.cai Dimensions (XY): 1912 x 1912
F V = 20171123_tERK_D_02_0Oh.czi Phasl Typax w6
U Iewe r ro! e B L L 2 L Pixels Size (XY) (nm): 70,58x70,58
=1 20171123 _tERK_D_02_3h.czi Z-sections/ Timepoints: 1x1
= 20171123 _tERK_D_03_3h.czi Channels: Ch2-T1, Ch1-T2 V4
and then 2] 20171125 8% .04 hca o] :
=] 20171123 _tERK_MG_01_3h.czi
1 Tags (1)
H - =] 20171123 _tERK_MG_02_3h.ca
View in ImageJ.. 2| 17125 e 03 s
=] 20171123 FRK_MG_04_3h.cd
R anias o Attachments (0)
< >
& Screens Ratings (0)
£ Attachments Communts (€)
'J Tags Located in
> Images
&) Administration
el . oL S, ¢ A el —

o
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Select image(s) to open in Fiji (2/2)

OR

Open image(s) by
right-click

View

and then

View in ImagelJ...

(or double-click)

+#* Mary Mayperson connected to

= 0O b 4
File Edit Window Help
[3 @ 54 !] i @ Display Groups ¥ Save Image] Results
r <
e~ ECIEEENE— =[P4 DT R
o AXS BO&K | [Workspace: 14 of 14 images mb LU
. GROUP ~ |l 20171123_tERK_D_01_0h.czi (07.09.2022) \ Annotate the selected Images = S ol
.. Mary Mayperson /
+ @l 2010_CMBE_ExpressionTest [2] Tags (1)
+ @b 2011_VTK_ZyxinConfocal [1] -
%@ ..._MPIMolBio_CrossSec_Lymphangio [1] View Py !J View...
=@ 2017_Nuc-Intens_Tcells [6] !] o ith J ‘ e
#- B 20171115_M33_pERK [25] penw 1 iew in Image)...
-5ad 20171123_M36_pERK [27) & Download...
9
- 20171123_M36_totalERK [14] Edit 1
E5]20171123_tERK D 01 _Oh.ca
E3]20171123 t6RK D _01_sh.cz X Delete
E3]20171123_tERK_D_02_Oh.cai Sioveto N
E3]20171123_ERK _D_02_3h.czi
PS120171123_tFRK D_03_3h.cdi Tag...

| 20171123_tERK_D_04_3h.czi

Rendering Settings >

D
:J 20171123 _tERK_MG_01_3h.czi
"j 20171123 _tERK_MG_02_3h.cai

=] 20171123_tERK_MG_03_3h.czi
| 20171123_tERK MG 04 3h.cai

1

< >
B Screens

@ Attachments

*) Tags

\») Images

&) Administration

J Search v A & -~ —‘Q— ~

B -
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Choose settings for loading the image(s) in Fiji

gy Bio-Formats Import Options X
Use your prefered settings Stk ewng etadee vewtg ol
. View stack with: [Hyperstack v | [ Display metadata Display OME-XML metadata - *
to open the image(s) as T — Displays  tro of motadata

. standardized into the OME data

reCIUII’ed fOf yOUF WOTk ™ Display ROW model. This structure is the same

ROls Import Mode: ]Ro‘ manager | regardless of file format, though
some formats will populate more

Dataset organization Memory management information than others.

L) t S name [ use virtual stack

L fil [~ Specify range for each series Examples:

I~ Swap dimensions I™ Crop on import ® The title of the dataset is

: listed under OME >

I~ Open ah series Image > Name.

[~ Concatenate series when compatible  Split into separate windows @ The time and date when
the dataset was acquired

[ Stitch tiles [V Spit channels is listed under OME >

Color options S Recutipess Image > (;reauynDa_te.

@ The physical pixel sizes
Color mode: [Defaut ~] [ spit timepoints of each plane in microns
[V Autoscale is listed under OME >

() () P9 ADD LOGO SMALL




View your images in Fiji and work with the image for processing
and analysis

File Edit Image Process Analyze Plugins Window Help
Ojo|c|o| /£ N AJB | A ofse|wr| | 4] & |Ri]>

i Is Just) ImageJ 2.3.0/1.53q; Java 1.8.0_322 [64-bit]

"c:1/3 - 20180130_X_tERK_3h_02"; 134.95x134.95 microns (1912x1912); 16-bit; 7M "¢:2/3 - 20180130_X_tERK_3h_02"; 134.95x134.95 microns (1912x1912); 16-bit; 7M
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Example — processing & analysis workflow to segment and count nuclei

Perform your workflow in Fiji
(here: segmentation and cell counting based on nuclear staining with DAPI)

Gaussian blur

Thresholding
(Huang)

Watershed

Analyze
Particles

Performed with Fiji: Schindelin, J., et al. Nat Methods 9, 676—-682 (2012). https://doi.org/10.1038/nmeth.2019
p11 See also: Haase R. Lecture Biolmage Analysis 2020: https://www.youtube.com/playlist?list=PL 5ESQNfM5Ic7SAMstEu082ivW4BDMvdOU ADD LOGO SMALL
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Example — processing & analysis workflow to segment and count nuclei

Perform your workflow in Fiji

(here: segmentation and cell counting based on nuclear staining with DAPI)

"c:3/3- 20180130_X_tERK_3h_02"; 134.95x134.95 microns (1912x1912); 8-bit; 3.5MB

il

0001-0030 ~|  Adam || 134.95x1 34.95 microns (1912x1912); 16-bit, 7MB
0002-0034
0003-0068 Léit: ..I
0004-0102
0005-0129 % . .

6-0136 I

o] ®
0008-0223 Properties .
£y ®
00110313 __More »

0012-0330 ¥ Show Al
0013-0340 v [ Labels ‘ ‘ .

File Edit Font Results ’ . . .
 [Lapel Area = . .
156 20180130_X_tERK_3h_02.c7i - C=2--OMERO ID:58037 29417
157 20180130_X_tERK_3h_D2.czi OMERO ID:58037 28.794 .

158 20180130_X_tERK_3h_02.cz - C=2--OMERO |D:58037 29825 .. ’

159 20180130 X_tERK_3h_02.c7i - C=2—-OMERO ID:58037 29492 . .

160 20180130_X_tERK_3h_02.czi - C=2-OMERO ID:58037 30403 . .

161  20180130_X_tERK_3h_02.czi - C=2--OMERO ID:56037 28.734 . .

162 20180130_X_tERK_3h_02.czi - C=2--OMERO ID:58037 30.134 . .

163 20180130_X_tERK_3h_D2.c7i - C=2--OMERO ID:58037 27599 . .
164 20180130_X_tERK_3h_02.czl - C=2--OMERO |D:58037 30.219
165 20180130_X_tERK_3h_D2.c7l - C=2-OMERO ID'58037 31230
166 20180130_X_tERK_3h_02.czi - C=2--OMERO ID:58037 31.240 .

167 20180130_X_tERK_3h_02.czi - C=2--OMERO ID:58037 31.763 .

168 20180130_X_tERK_3h_D2.c7l - C=2-OMERO ID:58037 31624 . ’

169 20180130_X_tERK_3h_02.czi - ( OMERO ID:58037 27.315
170 20180130_X_tERK_3h_02.czi - --OMERO |D:58037 27.280 . . .
171 20180130 X _tERK_3h_D2.czi - C=2-OMERO ID:58037 16753 | | ) [
172 20180130_X_tERK_3h_D2.czi --OMERO ID:58037 28.391 .
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Save Regions of Interest (ROIs) and Measurement Results to OMERO

Save to OMERO using the
plugin

Plugins
- OMERO
- Save ROIs to OMERO

(Fiji Is Just) Image) - O X
File Edit Image Process Analyze g
/o)a|o]/ </t N A @) wscos e
Magnifying glass (or "+" and "-" keys; alt or long click for Shortcuts |
Utilities v f

New »

"¢:3/3 - 20180130_X_tERK_3h_02"; 134.95x134.95 micron
Compile and Run

Install Strg+Umschalt+M
Install Plugin

3D Viewer
Analyze »
Bl
BigDataViewer
Bio-Formats
Cluster
Color Inspector 3D

Examples »
Feature Extraction »
HDF5
Image5D >
Integral Image Filters »
Janelia H265 Reader
LOCI
LSM Toolbox »
Landmarks

Multiview Reconstructio

Optic Flow

Ridone Detection

Connect to OMERO
Save Image(s) to OMERO
Process Save ROIs to OMERO €RK_3h_02.c7i- C

Registration *| Save Resultsto OMERO  X_tERK_3h_02.czi- C
—' 4 T

0001-0030 Al Add
0002-0034 Update
0003-0068 S
0004-0102
0005-0129 _Rename... |
0006-0136 _ Measure_|
0007-0182 Deselect
0008-0223 Properties
0009-0250 Flatten [F]
0010-0251
0011-0313 More »
00120330 ¥ Show All
0013-0340 v [¥ Labels
File Edit Font Results
[Label Area  *
156 20180130 _X_tERK_3h_02.czi - C=2--OMERO ID:58037 29.417
167 20180130_X_tERK_3h_02.czi - --OMERO 1D:58037 28.794
168 20180130_X_tERK_3h_02.czi - C=2--OMERO ID:58037 29.825
189 20180130_X_tERK_3h_02.czi - C=2--OMERO ID:58037 29492
160 20180130_X_tERK_3h_02.czi - C=2--OMERO |D:58037 30403
161 20180130_X_tERK_3h_02.czi - C=2--OMERO |D:58037 28.734
162 20180130_X_tERK_3h_02.czi - C=2--OMERO ID:58037 30.134
163 20180130_X_tERK_3h_02.czi - C=2--OMERO ID:58037 27.599
164 20180130_X_tERK_3h_02.czl - C=2--OMERO |D:568037 30.219
165 20180130_X_tERK_3h_02.czi - --OMERO |D:58037 31.230
166 20180130_X_tERK_3h_02.czi - C=2--OMERO ID:58037 31.240
167 20180130_X_tERK_3h_02.czl - C=2--OMERO ID:58037 31.763
--OMERO 1D:58037 31.624
--OMERO |D:58037 27.315
T --OMERO 1D:58037 27.280
2 --OMEROQ ID:58037 16.753
--OMERO |D:58037 28.391

Ivl4
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Choose settings for saving in OMERO

1 2
+*+ Save Image) results X v& Import images
Save results for
(®) Image from current window Import any selected images not aready
saved in OMERO to the OMERO server?
(O Images from all image windows If Yes, the ROIs and results will be saved on the new images.

If No, the ROIs and results will be saved on the original images.

Measurements File Name: —— ﬁ Z\K

p 14 ADD LOGO SMALL




A — Upload the mask image to OMERO as a new image

Choose upload destination (Group, User, Project, Dataset) and upload

1

+=* Import Location - Select where to import your data.
Group [, GROUP “
Import For Mary Mayperson v

@ Projects g Sareens

Project 2017 _Nuc-Intens_Tcells

Dataset 20180130_M42_totalERK

Close Refresh

2

<+ Import Data - O X

Window Help

Import Data: 1 (no filter for objects; no predefinitions) \
L X J
monitor imports. f

SelectData to Import | Speafy MetaData \/Inwtnq

Report: 2 out of 1 uploaded Show Failed When upload is complete, the import

Import Size: 7 ME window and OMERO session can be closed.
Reading will continue on the server.

- 20180130_X_{ERK_3h_02._cz2i-C=2—OMEROID_S8037.ome. tif Upload Processing NI
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A —View the imported mask image and the analysis results
(e.g., in OMERO.web)

Webclient X |+

6 al o A

s = @ L @

e+ OMERO Data Histoy Mapr Figure Help TagSearch  Forms Designer o, f’

" GROUP Mary Mayperson

Thumbnails = General | Acquisition  Preview

§  Mary Mayperson
a'a

[

Explore Tags Shares Add filter v aa Image ID: 58712

e .

Image Details
Add Description
Import Date:
Dimensions (XY):
Pixels Type:
Pixels Size (XYZ) (um):
Z-sections/Timepoints:
Channels:
ROI Count:

Tags

Key-Value Pairs

ROl image
uploaded as —
new file muANE

neW I D | il 2022_Ex eData_BIA-S-BSST749 .
( ) il OpenSPIM Example Datasset aS a.ttaCh ment I n

Tables

_X_tERK_3h_02_czi-C=2—OMERO
_X_tERK_3h_03.c

Results uploaded

Attachments

N

Owner:  Mary Mayperson Showall v |

[j Orphaned Im
» il csv-format :
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B — Add the ROI to the orginal image in OMERO

Review the ROIs on the original image with OMERO.iviewer

[ | % 20180130.X1ERK 3 02czi x |+ - =) >

< c @ s @ L & -

' Activities X OMERO  Fie~ ROIs- Help~ 20180130_X_tERK_3h_02.czi

! o - 4 311 % X: 1 0002-0034 < 2

:
= B

: Clear List l

ROIs Saved Remove

z b7 o

B Oos¢NNSOT

seg 3

(<<

[ << ]

(W< <M<

|

p17 ADD LOGO SMALL



A and B combined

In the OMERO.iviewer you can copy the ROI from the segementation image to the
original image manually, too.

b-OMEROID_58037.ome.tif OMERO  Fie- ROls- Hep- 201801 T
: == 3. Paste to -

the selected
original image

mT o

B ODoe¢rvNsOT

& show Z: T: C Commen it

0087-1840
0087-1840
0088-1850
0088-1850
0089-1873
0089-1873

0 0O 0 (50 (

oo ooQo@

0080-1880

Max Mustermann

o

0080-1880

1. Select all
ROIs (Ctrl+A)

0091-1888
0091-1888
0092-1904
0092-1904

0093-1905

a0 @

0093-1905
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Batch processing, macros and scripts for Fiji and OMERO

Running image analysis pipelines with Fiji over several images from OMERO

in batch is possible, too.

Recommended: OMERO Macro Extension & OMERO batch plugin

E100O0OResearch

F1000Research 2022, 11:392 Last updated: 06 JUL 2023

SOFTWARE TOOL ARTICLE

Frédéric Brau:2*

2Université Céte d’Azur, CNRS, IPMC, Valbonne, France

Lille, 59000, France

1GReD, CNRS, INSERM, Université Clermont Auvergne, Clermont-Ferrand, France

3polytech Nice Sophia, Campus SophiaTech, Sophia Antipolis, France
4Univ. Lille, CNRS, Inserm, CHU Lille, Institut Pasteur de Lille, U1019 - UMS 9017 - CIIL - Center for Infection and Immunity of Lille,

M) Check for updates

Easing batch image processing from OMERO: a new toolbox
for Imagej[version 1; peer review: 2 approved]

Pierre Pouchin':1, Rayan Zoghlami2, Rémi Valarcher', Maxence Delannoy':3,
Manon Carvalho3, Clémence Belle3, Marc Mongy4, Sophie Desset',

https://omero-guides.readthedocs.io/en/latest/fiji/docs/index.html

File Edit Language Templates Run Tools Window Options F access.. — O X
Outline Macroijm  accessOMERO_Christian_Try.ijm
File Explorer 16  //This feature will enable the consecutive macro functions

+

17 ~un("OMERO Extensions™);
//Connect to OMERO with the given variables
Ext.connectToOMERO(host, port, username, pwd);

pwd = "mockpassword”
images = Ext.list("images", "dataset”, dataset_id);
24  imagelds_array = split(images,","); //retrieves the indivi

// The for-lLoop defines which action is performed with eac
// One image after another is processed with the function

Last index of the array is logically one less than

(imageIds_array) i<2
; i<lengthOf(imagelds_array); i++){
imageplusID = Ext.getImage(imageIds_array[i]);
img_nuclearintensitymeasure();
//save the ROI to OMERO
NROIS = Ext.saveROIs(imageIds_array[i]);
/ del he ROI manager table after the ROI was save

il "Delete”);
nt("finished for " + imageplusID); //this is impler

Ext.disconnect()

Run Batch REPL Show Errors Clear »>

Pouchin et al., F1000Research 2022, 11:392 (https://doi.org/10.12688/f1000research.110385.1)
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JiPipe visual macro programming with a connection to OMERO

Batch processing in Fiji/imageJ and the connection to OMERO can now be
established with a graphical user interface (GUI) in the software JiPipe:

Correspondence

https://doi.org/10.1038/s41592-022-01744-4

JIPipe: visual batch processing for Image)

®|Check for updates

he growth in microscopy adoption
has led to a concomitant upsurge
in the development of software
tools for the automated analysis
ofimage data. Pillars among these
tools are ImageJ* and its Fiji’ distribution,
whichhave been serving the imaging commu-
nity for decades and continue to gain public
support to keep up with the quantification

needs of the newest and most-demanding
microscopy techniques. The hallmark of
Image] isitsintuitive graphical user interface,
which provides access to its many tools. On
the other hand, the creation of reproducible
batch-processing workflows is only possible
using a macro language. As programming
skills are uncommon among experimental-
ists’, the need for scripting contributes to an
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already-existing communicationgap between
life and computer scientists. Visual program-
ming languages that replace the writing of
text commandswith the design ofa flowchart
offer a solution. Existing tools contribute to
this effort by providing a visual way to build
pipelines or by simplifying the scripting proce-
dure (Supplementary Information, section1).
Our newly developed visual programming

JiP JIPipe

JIPipe

Macro programming for everyone!

Gerst et al., Nat Methods 20, 168-169 (2023). https://doi.org/10.1038/s41592-022-01744-4
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Extended resources on using Fiji and OMERO

Official OMERO guide:
https://omero-guides.readthedocs.io/en/latest/fiji/docs/index.html

A workshop on image analysis with Fiji and OMERO:
https://learning.rc.virginia.edu/notes/fiji-omero/

Workshop recordings by the Open Microscopy Environment Consortium on YouTube,
including scripting in Fiji:

https://www.youtube.com/watch?v=W5EDx3yKA o
(https://www.youtube.com/watch?v=dOtnEO-nmiq)

Image Analysis Lecture by Robert Haase (TU Dresden):
https://www.youtube.com/playlist?list=PL5ESQNfM5Ic7SAMstEu082ivwW4BDMvd0OU

Help for Image Analysis or OMERO-related issues - Image.sc forum:
https://image.sc
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